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NpepucnoBune

Visual Basic — 410 3710?

B ImocjIEAHEE BpPEMs BO3POC HMHTEPEC K NMPOrpaMMHUPOBAHUIO, YTO
CBA3daHO C PA3BUTUEM M BHCIAPECHUEM B IIOBCEIHCBHYIO KM3Hb MH-
(l)OpMaL[I/IOHHO—KOMMYHI/IKH_]_[I/IOHHI)IX texHonoruii. Ecam dyemosek
HUMEET I€JI0 C KOMIIbIOTEPOM, TO paHO MJIM IIO3IHO Y HETO BOZHUKACT
2KeJI1aHue, a UHoraa u H€O6XOZ[I/IMOCTL nporpaMMmpoBarhb.

Cpenn Tonb3oBaTesicil MepCOHATBHBIX KOMITBIOTEPOB B HACTOSIIEE
BpeMsl1 Haubojiee TOIMYJISIPHO CEeMEMCTBO OIepallMOHHBIX CHUCTEM
Windows u, ecTecTBEHHO, YTO TOT, KTO COOMpAaeTcsT IMporpaMMUpoO-
BaTb, CTPEMUTCSI MUCAThb IPOrpaMMbI, KOTOpbie OyayT paboTaTh B
3TUX CHCTEMaX.

PaHbllle psimoBOMYy MPOrpaMMUCTY OCTaBalOCh TOJBKO MeuTaTh
O CO3IAaHMM COOCTBEHHBIX IIporpamMMm, paboTarmolux B cpeae Win-
dows, T. K. cpeiactBa pa3paboTKu ObLIM SIBHO OPUEHTUPOBAHBI Ha
MpodecCUOHATIOB, 00IaNAI0IINUX CEPhe3HBIMU 3HAHUSIMU U OTIBITOM.

BypHoe pasBuTHE BBIYMCIMTEIBLHON TEXHMKM, MOTPEOHOCTh B (-
(peKTUBHBIX CpEICTBAX pa3pabOTKU IPOTPAMMHOTO ObeCTIeYeHUS
MpUBEIM K TOSIBAEHUIO CUCTEM IIPOrpaMMMPOBAHMS, OPUEHTHPO-
BAHHBIX HAa TaK Ha3bIBaeMylo "OBICTPYIO pa3paboTKy", MMOHEPOM Cpe-
I1 KOTOPBIX ObLT makeT Microsoft Visual Basic.

B ocHoBe cucrem ObicTpoii paszpaborku (RAD-cucrem, Rapid
Application Development — cpena ObIcTpoil pa3paboTKu TpUIOXe-
HUI) JEXUT TEXHOJIOTHS BU3YAIBHOTO MPOEKTUPOBAHUS U COOBITHI -
Horo mnporpaMmupoBaHusi. CyThb 5TOH TEXHOJOTMM 3aKJIIOYaeTcsl B
TOM, YTO cpefa pa3paboTKu OepeT Ha cedsl OOJbIIYI0 YacTb PYTUH-
HOM paboThI, OCTABIISIST MPOTPAMMUCTY PAbOTy IO KOHCTPYHPOBAHUIO
JIUAaJIOTOBBIX OKOH M (YHKIUI 00paboTku cobbituii. [IpousBomu-
TEJIbHOCTb TMpOrpaMMMCTa TpU Uclodb3oBaHuM RAD-cuctem —
¢aHTacTUueckas!



2 lpeaucnosue

Microsoft Visual Basic — 3T0 cpena O6nicTpoil pazpaboTKu, B KOTOPOit
B KauecTBe s3blKka MporpaMMMpOBaHUs ucmojb3yeTcs: Visual Basic.
B ocnoBe upeonmormu Visual Basic JeXUT TeXHOJOIMS BU3YyaJIbHOTO
MPOEKTUPOBAHUSI U METOMOJOrUsl OOBEKTHO-OPUEHTUPOBAHHOTO CO-
OBITUITHOTO TIPOTPAMMMPOBAHHS.

B HacTosiiee Bpemss Haubosiee LIMPOKO MCIIOJIB3YeTCs 1ecTasi Bep-
cug makera — Microsoft Visual Basic 6.0, koTopast o3BoJsieT co3a-
BaTh caMble Pa3IUYHbIE MPOTPAMMBI: OT MPOCTEUINNX OTHOOKOHHBIX
MPUIIOXKEHUI O MporpaMMm YIIpaBleHUs paclpeneieHHBIMU O6azamu
JAHHBIX.

Microsoft Visual Basic moxer paboTaTh B cpene omnepallOHHBIX CHC-
teM oT Windows 98 nmo Windows XP. Ocobbix TpeboBaHuUi, MO cOBpe-
MEHHBIM MepKaM, K pecypcaM KOMITbIOTepa MaKeT He MpeabsBIseT.

O6 31Ol KHMre

B xnure, koropas mocpsileHa MPOrpaMMHUPOBAHUI0 B KOHKpPETHOM
cpene, HeoOXoIUM OaTaHC MEXIy TpeMs JMHUSIMU:

O A3BIK TIPOTPaMMMPOBAHNS;

O TexHMKA M TEXHOJIOIMs IPOrpaMMUpOBaHUs (IIPOrpaMMHMPOBAHME
KaK TaKoBOE);

O cpena pa3paboTKH.

YT00Bl OmucaTh mpoliecc pa3paboOTKM MPOrpaMMbl, OOBSICHUTH, KakK
OHa paboTaeT, HYXXHO OMNEepUpOBaTh TaKUMM TEPMHUHAMU, KaK 008-
ekm, cobvimue, c8olicmeo, TTOHUMAHUE KOTOPbIX Ha HAYaJIbHOM 3Tarle
HU3yYeHUsT TIPOrpaMMHUPOBAHMSI BecbMa TpobieMatuyHo. Kak mocty-
muth? CHavana AaTh ONMMCAHUE SI3bIKA, & 3aTeM MPUCTYIUTh K OMU-
CaHMIO cpelbl pa3paboTKU M Tpoliecca MporpaMmmupoBaHus B Visual
Basic? OyeBumHO, 4yTO 3TO He Jydluuii BapuaHt. IlosToMmy mpu us-
JIOKEHUW MaTepuayia TMPUHSIT Moaxon (MeTom), KOTOPBIi MOXHO Ha-
3BaTh "or 3amaun”. CyTh MeTo;a 3aKJlouyaeTcs B TOM, UTO OepeTcs
KOHKpeTHas 3ajaya U Ha ee MpHUMepe paccMaTpuBalOTCs OIpenesieH-
Hasl TEXHOJIOTHS, BO3MOXHOCTH Cpenbl pa3paboTKM W OCOOEHHOCTH
sI3pIKA MPOrpaMMUPOBAHUSI, HEOOXOOUMBIE UISI pEeIIeHUsT 3TON KOH-
KPETHOM 3a1auu.



lpeaucnosue 3

KHura, kotopyto Bbl JepXHTe B pyKax, — 3TO He OMUCAaHUE s3blKa
MporpaMMuUpoBaHMsl U cpeibl pazpaboTku Visual Basic. Bto pykoBo-
JcTBO (yuebHoe mocobue) 1o nporpaMMmupoBaHuio B Microsoft Visual
Basic. B HeM paccMoTpeHa Bcsl Lielo4yKa, Bech MpoLecC CO3AAHUS
MpOrpaMMbl: OT pa3pabOTKU AMAJIOTOBOTO OKHA W MpouLeayp obpa-
OOTKM COOBITHII IO CO3MAHUSI CITPABOYHOM CUCTEMBI.

Llenp aTOM KHUTM — HAy4dyuTh MporpaMmupoBaTh B Microsoft Visual
Basic 6.0, T. e. co3maBaTh 3aKOHYEHHbIE IIPOrPaMMBbI Pa3IMYHOIO Ha-
3HAYEHUS: OT MPOCTHIX OJHOOKOHHBIX MPUIOXKEHUH MO BIOJHE MpO-
deccuoHaNbHBIX TTPOrpaMM paboOThI ¢ 6a3aMK JAHHBIX.

Hayuutbcst mporpaMMupoBaTh MOXKHO TOJIBKO B IIPOIECCE PEIIeHUS
KOHKpETHBIX 3amady. I[lo3ToMy, 4YTOOBI TIONYYNTh MAaKCHMAaJIbHYIO
MOJTb3y OT KHMTH, BBl IOJIKHBI paboTaTh ¢ Heil akTuBHO. He 3aHm-
MaiTech IMPOCTO YTEHHEM IPUMEPOB, PEATU3YTe WX C ITOMOIIBIO
Balmero Kommplorepa. He OoiiTech 3KCIepHMMEHTHPOBATh, BHOCHUTE
W3MEHEHUST B TTPOTPAMMBI — YeM OOJIbIIIe CIeIaeTe CaMOCTOSTENIBHO,
TeM OOJIbIIIeMY BBl HAyUHUTECH!






YACTb |

CPEOA PA3SPABOTKU
MICROSOFT VISUAL BASIC



IlepBas yacTb KHUIM 3HAKOMMT YMTaTeNid CO Cpeloll pa3pabdoTKU
Microsoft Visual Basic. Ha npumepe nporpammbl Konseprop, KoTO-
past TTO3BOJISIET TepeCcYNTaTh IIeHY M3 JOJUIapoB B pyOJIH, IeMOHCTPH-
pyeTcsl TIpoIlecC CO3MAHUS TPOrpaMMBI (TEXHOJIOTUS BU3YaJIbHOTO
MMPOCKTUPOBAHUS W COOBITHMITHOTO TTPOTPAMMHPOBAHUS), BBOIATCS
OCHOBHBIE TIOHSITUS U TEPMHHBI OOBEKTHO-OPMEHTUPOBAHHOTO IIPO-
rpaMMupoBaHus. Takke B ITepBOI YacTH MPUBEICHO OMMCcaHue 6a30-
BBIX U JIOTIOJTHUTEbHBIX KOMITOHEHTOB.



naBa 1

YcTaHOBKaA

YcranasnuBaerca Microsoft Visual Basic o0bryHBIM 0Opaszom. IIpo-
rpaMMa yCTaHOBKHM CTapTyeT aBTOMAaTHYECKHU.

Puc. 1.1. nanoroesoe okHO
BbiGOpa BapnaHTa yCTaHOBKM



8 Yacrb I. Cpega paspaborku Microsoft Visual Basic

ITocae Toro kak ycraHoBouHbi CD Oymer momelleH B OUCKOBOII,
Hallo BBECTUM PErucTpaldoOHHYI0 MH(poOpMaluMio M BbIOpaTh Karaior,
KyJa Tpeanoaraercsl ycraHoBuTh Visual Basic, a 3aTem BbIOparh Ba-
puaHT yctaHoBKH (puc. 1.1):

O Typical (O6bIuHbIi). B 3TOM ciyyae ¢ yctaHoBoyHoro CD Ha xe-
CTKMI JUCK KOMIbloTepa OyAyT CKONMUPOBAHBI BCE OCHOBHbBIE
koMmIoHeHTbl Microsoft Visual Basic (yuine BbIOpaTb MMEHHO
3TOT BApUAHT YCTAHOBKH);

O Custom (BbiOopouHbIii, ompeneiseMblii MPOrpaMMucTOM). DTOT
BApUAHT TO3BOJISIET MPOrPAMMMCTY CaMOMY BBbIOpaTb KOMITOHEH-
Thl, KOTOpblE HaIO YCTAaHOBUTb. PeKoMmeHayeTcsi B TOM cllyyae,
Korja Ha JucKe KOMITbIOTEpa HEJOCTaTOYHO CBOOOJHOIO MecTa
JUTSl TIOJTHOM YCTAaHOBKM.

ITo oxoHyaHuM Tpolecca KonupoBaHUs ¢aiioB MporpaMma ycra-
HOBKHU TIpe[yiaraer rnepe3anycTUTh KOMITbIOTEp, a Tociie mepe3arpys-
K1 noMmecTuThb B CD-aucKoBOJ KOMMAKT-IMCK, HA KOTOPOM HAaxo-
autcss MSDN Library (Microsoft Developer Network — cripaBouHas
cuctema Microsoft Visual Studio). Bo3amoxkHbl Tpu BapuaHTa ycTa-
HoBkM MSDN:

O Typical (OO6brunHbIit). [lpenmonaraercs, 4To Ha KECTKUN IMCK
KOMIIblOTEpa OyIeT CKONMMPOBAHO SIIPO CIPABOYHOW CHCTEMBI
(opsinka 60 MGaiiT), a Bca ocranbHasg MHGpopMauus Oymer 3a-
rpyXarbcs Mo Mepe HEOOXOMUMOCTH ¢ KOMITaKT-AMCKa;

O Custom (BbsibopouHblit). DTOT BapUaHT MO3BOJNSIET TPOTPAMMUCTY
BBIOpaTh pas3mesibl CIPaBOYHON WH@OpMAILMKU, KOTopbie OymyT
CKOMMPOBAaHBI HA TUCK KOMITIbIOTEPA, OCTANIbHBIE pa3iesbl TaKKe
OymyT HOCTYNHBI, HO TOJBKO TOTHA, KOTAAa KOMIIAKT-AUCK C
MSDN HaxomuTcs B TUCKOBOJE;

3 Full (ITonuslit). B atoM cinyuae Bcst cripaBouyHass WHMoOpMaLus
(mopsimka 800 M6GaiiT) 6yneT ckonmMpoBaHa Ha KECTKUI THUCK.

Ecnu mporpammuct mnpeamnosaraet padorarts Toibko ¢ Visual Basic,
peKoMeHIyeTcsl BhIOpaTh BbIOOpouHbIid (Custom) BapuaHT yCTAHOBKH
MSDN (puc. 1.2), a 3arem pasaensl: VB Documentation (JloxymeH-
tauust Visual Basic), VB Product Samples (ITpumeps! Visual Basic) u
VS Shared Documentation (O61iast nokymeHTaius Visual Studio).
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Puc. 1.2. YctaHoBka MSDN-crnpaBo4HOl CUCTEMBI

Hauano pa6oTtbl

3amyckaercs Visual Basic oObIYHBIM 00pa3oMm, T. €. BHIOOPOM KOMaH-
ael ITyck » TIporpammer » Microsoft Visual Basic 6.0 » Microsoft
Visual Basic 6.0 (puc. 1.3).

Ecnmu Visual Basic 3amylieH cpasy Iocjie YCTaHOBKM, TO Ha (poHe
[JIJaBHOTO OKHa orobOpaxaeTcssi okHo New Project (puc. 1.4). B stoMm
OKHe Ha BKJajake New repeurciieHbl BUAbl MTporpaMmM (MPOEeKTOB), KO-
Topble MOXHO co3naTh B Visual Basic. YToObl mpuctynuTh K pabote
Han HOBbIM Windows-npuaoxcenuem, Hago BbiOpaTh Standard EXE u
EJKHYTh Ha KHomke OtkpbiTh. Eciu mocie 3amycka Visual Basic ok-
Ho New Project Ha skpaHe He oToOpaxkaercs, TO AJIs TOrO YTOOBI OHO
crajio AocTynHbIM, Hajo B MeHI0 File Boiopath komanny New Project.
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Puc. 1.3. 3anyck Visual Basic

Puc. 1.4. Hayano pa6oTbl Hag HOBOW NMporpamMmoi
(Windows-npunoxeHuem)
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Bun oxna Visual Basic B Havase paboTbl Haa CTaHAAPTHBIM
Windows-nipuiioxxeHueM mnpuBeaeH Ha puc. 1.5. B BepxHeil uactu
OKHA HaxoAMTCsl CTpOKa MEHIO M CTaHAapTHasl MaHejlb MHCTPYMEH-
TOB, CJ€BA — HAAUMPA KOMHNOHEHMO8, B LIEHTPE — OKHO KOHCMDYK-
mopa ¢opmbl, CTIpaBa — OKHO MeHedcepa npoekma, OKHO cgolicme 1
OKHO 0mo0Opasdcenus noA0X4CeHuUs Popmbl.

Puc. 1.5. OkHo Visual Basic
B Hayane paboTbl Haf HOBOW NPOrpamMmmon

Ha cranpmaprHoii maHeau mHCTpyMeHTOB (puc. 1.6) HaxomsaTcsl KHOII-
KW, COOTBETCTBYIOIIME HaWOoJjiee YacTO MCITONBb3YeMBbIM KOMAaHIAM.
3mech Xe pacrojaraloTcsi KHOIKH, ¢ TIOMOIIbI0 KOTOPBIX MOXHO ObI-
CTPO CHeNaTh TOCTYITHBIMU OKHA MAMTPHI KOMIIOHEHTOB, MEHEIKepa
MIPOEKTOB, CBOMCTB M JIp.

B okHe koHcTpykTOopa dopmbl (puc. 1.7) Haxomutcst ¢popma, KOTo-
past ImpejacTaBisieT coboif 3aroTOBKY OKHa pa3pabaThiBAeMOIO IpH-
JIOXEHMSI.
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Puc. 1.6. CtaHgapTHasa naHenb UHCTPYMEHTOB

Puc. 1.7. OkHO KOHCTpyKTOpa POpPMbI

B namutpe kommoHeHToB (puc. 1.8) HaxomsTcs 3HAukKu, OOO3Ha-
Yalolllue KOMHOHeHMbl — BJeMEHTbl MHTepdelica Moib30BaTensl, Ko-
TOpBIE TIPOTPAaMMHUCT MOXET ITOMECTUTh Ha TOBEPXHOCTH (DOPMBL.
Eciau manutpa KOMIIOHEHTOB He OoToOpaxaercs, TO ISl TOTO YTOObI
OHa cTaja JOCTYIHOM, Hago BbIOpaTh KoMaHay View » Toolbox win
IIEJKHYTh HA COOTBETCTBYIOIIEH KHOIKE MaHeJIu WHCTPYMEHTOB.

B okHe MeHemxkepa npoekTa (puc. 1.9) otobpaxaercsi cTpykTypa (co-
CTaB) MpoOeKTa, HaJ KOTOPbIM B AaHHbI MOMeHT uaeT paborta. Eciau
OKHO MeHeJkepa MpoekTa He oToOpaxaeTrcsi, TO JAJIsl TOTO YTOObl OHO
cTajo JOCTYIIHBIM, Hamo BeiOpath KomaHay View » Project Explorer
WU 1IEeJKHYTh Ha COOTBETCTBYIOIEH KHOMKE MaHeId MHCTPYMEHTOB.



naBa 1. YcTtaHoBKa 13

Puc. 1.9. B okHe Project
oTobpaxaeTca CTpPykTypa
(cocTaB) npoekTa

Puc. 1.8. Manutpa KOMNOHEHTOB
(okHO Toolbox)

OkHo cBoiicTB (puc. 1.10) mpenHazHayeHO AJig OTOOpaxkeHUs] U pe-
JNAKTUPOBAHUSI 3HAYECHUI CBOMCTB 00BEKTOB. B TepMuHOJIOIMY BU3Y-
AJIPHOTO IIPOEKTUPOBAHUS 006eKm — 3TO OUAJIOTOBOE OKHO MJIM 3Jjie-
MeHT uHTepdeiica moyb3oBaTeis (Ioje BBOAA, KOMAaHIHAS KHOIIKA,
nepexyoyaTeslb U 1Ip.).

Ceoiicmeo — 3TO XapaKTepHCTHKA, KOTopas oImpenenser (3amacT)
BHEIIHUI BHMI oOBeKTa. Hampumep, 3HaUYeHHMe CBOMCTBA Caption
3aaeT 3aroJIOBOK (POPMBI, @ CBOMCTB Width M Height — €€ pasMmep.
CsoiictBa Ha Bkianke Alphabetic oToGpaxarorcs B andaBUTHOM IO-
psinke, a Ha Bkiangke Categorized crpynnupoBaHbl. Hampumep, B
IpyImy Appearance oObeIMHEHbI CBOMCTBA, KOTOpBIE OIpPEAENsIOT
BUI (popMbl (3arojloBoK, (DOHOBBII PUCYHOK, TUII TPAHUIILI U T. 1.), a
B rpynny Position — cBoiicTBa, ompenessioniue pasMep UM Mojoxe-
HHE Ha KpaHe.
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Puc. 1.10. B okHe Properties nepeuncneHbl cBoicTBa 06bekTa
M yKa3aHbl X 3HA4YeHUs



naBa 2

MepBbli NpOeKT

ITpouiecc cozmanusi mporpammbl (Windows-nipunoxenusi) B Visual
Basic paccmorpum Ha mpumepe. IlycTh Hamo co3nmaTh MpoOrpammy,
KOTOpasi TepecuuThiBaeT 1LIeHy U3 J0J1apoB B pyonu. Bug okHa mpo-
rpaMMbl BO BpeMsl ee paboThl Mocjie BBOAA MCXOMHBIX JAHHBIX U
menuka Ha kHonke Ilepecuer npuBeneH Ha puc. 2.1.

Puc. 2.1. OkHO nporpamMmbl nepecyeTa LeHbI
13 [0NNapoB B py6nun

Y1obObl HavyaTh pabOTy HaJ HOBOM MpOrpaMMoOil WJIM, KakK MPUHSTO
TOBOPHUTDb, HAJ HOBBIM MpoeKToM, 3amyctuTe Visual Basic, Ha BKiaa-
ke New okHa New Project Boioepure Standard EXE u 1menkHute Ha
kHornike OtkpbiTh. Ecnu mocne 3amycka Visual Basic okHo New
Project He oroOpaxaercsa, To BbiOepuTe KomaHay File » New
Project.
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®dopma

Pabora Ham HOBBIM npoexmom (TaK TPUHSATO HA3bIBATh MPOrpaMMy
(TIputoXeHue), Ham KOTOpoi MaeT paboTa) HAYMHAETCS C CO3MAHUS
WM, KaK MHOTAA TOBOPST, C HACTPOMKU CTApTOBOI (pOPMBI.

CrapToBas ¢opMa cozmaercs MyTeM M3MEHEHMs] 3HAYeHUM CBOWCTB,
HaxonglIuxcs B okHe ausaiiHepa ¢opmbl Forml, u mobapneHus K
aToil hopMe HeoOXOMMMBIX KOMIIOHEHTOB (ToJieil BBOIA, OToOpaxe-
HUS TeKCTa, KOMAHIHBIX KHOIMOK M T. 1I.).

g mpocMoTpa U U3MEHEHMS] 3HAYEHUIA CBOUCTB (hOPMBbI U €€ KOM-
IMIOHEHTOB MCIIOJib3yeTcsl okHO Properties. B BepxHeil yactu 3TOro
OKHa yKa3aHO UMSI o0beKTa, 3HAYEHUS] CBOWMCTB KOTOPOTO OTOOpa-
XalTcs B JAaHHBI MOMEHT. B JieBoil KOJIOHKE OKHa MepeyrciieHbl
CBOICTBA 00BbEKTA, B IIPaBOl — YKa3aHbI 3HAYCHUSI CBOMCTB.

Hexkotopnie cBolicTBa (popmbl MTpuBeaeHbI B Ta0I. 2.1.

Ta6nuya 2.1. CovicTea ¢popmMsbl (06bexTa Form)

CeoiicTBO Onuncanmne

Name Nmsa dbopmsl.
Mcnonbayetca ana goctyna k popme 1 ee Komro-
HeHTaMm

Caption TekcT 3aronoska

Width LLunpuHa doopmbl. 3agaeTca B TBUNAX

Height BbicoTa chopMmbl. 3apaeTcs B TBUMNAX

StartUpPosition [MonoxeHue dopMbl Npy ee NOABAEHUN Ha 3KpaHe.

DdopMa MOXeT pacrofiaraTbCsl B LEHTpe sKpaHa
(Center Screen), B UEHTpe poaUTENbCKOI
dopmbl (Center Owner).

[MonoxeHue cpopMbl MOryT onpefensTb 3Ha4YeHUs
CBOWCTB Top W Left (B 9TOM cnyuae 3HavyeHue
CBolicTBa StartUpPosition AOMmKHO bbITb paB-
HO Manual)

Top PacctosHue oT BepxHeii rpaHuLpl dhopMbl 40
BEpXHell rpaHuLbl 3KpaHa Um 0o BepXHeli rpaHu-
Lbl poauTenbckoil popMbl
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Ta6nuya 2.1 (npogosxeHue)

CBoiicTBO

OnucaHune

Left

Icon

MaxButton

MinButton

BorderStyle

BackColor

ScaleMode

PaccTosHue ot neBoit rpaHuLbl opmMbl A0 NeBol
rpaHuLpbl SKpaHa Unmn Jo NeBoi rpaHuLbl poau-
TenbcKoli hopMbl

3Hauok (KapTuHKa) B 3arosioBke, obosHavaloLas
CUCTEMHOE MEHIo

MpusHak Hanuuus B 3arosfioBke okHa KHomnku Pas-
BepHyTb

Mpr3Hak HanMunsa B 3arofloBKe OKHa KHOMKM
CBepHyTb

Ctunb (Bua) rpaHuupl.
[paHuLa MoxeT 6bITb:
e 06blyHOI (Sizable);

e TOHKOI (Fixed Single) (B aTOM cnyvae us-
MeHWUTb pasMep OKHa nyTeM nepemeLLeHNs
rpaHunLibl MbllLbiO HeNb3s);

e BoOblLLe oTcyTcTBOBaTh (None).

Ecnu sHayeHue cBolicTBa paBHO Fixed Dialog,
TO rpaHuLa OKHa TOHKas U KHomku PasBepHyTb 1
CBepHYTb B 3arofioBke He oTobpaxatotcs

LieeT coopmbl.

LleeT MoxHO 3apathb, BoibpaB ero U3 nanuTpbl unu
yKasae MpUBA3KY K 35IeMEHTY LiBETOBOIA CXEMb
onepauuoHHo cuctemel. Bo BTopoMm cryyae uBeT
onpepenseTca TEKyLLEN LIBETOBOIN CXEMOIA U Bbl-
6paHHbIM KOMMOHEHTOM MPUBA3KU, U MEHsIeTCS
npu U3MeHeHUN LBETOBOI CXEMbl OMepaLoHHO
cucTEMBI

Onpegenser (sagaet) eguHULY U3MepeHus pas-
MepOB KOMMOHEHTOB, KOTOpble HaXOAATCA Ha Mo-
BepXxHocTU chbopMbl. PasMep KOMMOHEHTOB MoXeT
usmepaTsea B TBunax (Twip), nukcenax (Pixel) n
APYruX eauHULAaX
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Tabnuya 2.1 (okoHyaHue)

CBoiicTBO OnucaHune

Font LLpudT, KoTOpLI MO YMONYaHWMIO UCMONb3yeTcs
HaxogALLMMUCS Ha NMOBEPXHOCTU POPMbI KOMMO-
HeHTaMu ans oTobpaxeHus TekcTa (Hanpumep,
HaAnNucb Ha KOMaHAHO KHOMKe, TEKCT B rone
peaakTUpOBaHUA UMK B Mosie OTOBpaKeHUs TekcTa)

CHavaja Hajo 3aJarh 3arojoBoK ¢GopMbl — HM3MEHUTb 3HAYEHUE
CBOMCTBA Caption € Forml HA KoHBepTOp. Yrobnl 3TO CcIenarb,
HYXHO B okHe Properties BbIOpaTh CBOMCTBO Caption M IIEJIKHYTb
MBIIIBIO B IIOJIe 3HAYeHUsI CBOMcTBAa. B pesynbTaTe aTUX neilcTBUIA B
roJjie 3HaYeHus CBOMCTBA (ITOCNe CJIOBAa Forml) TMOSBUTCS Kypcop U
MOXHO OyJeT BBECTH 3HaueHue cBoiicTBa (puc. 2.2).

Puc. 2.2. N1ameHeHne 3Ha4eHns CBOCTBA
nyTemMm BBOAA CTPOKMU
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Cnenyer oOpaTuTh BHUMaHME, YTO IIMPUHA U BbicoTa (hOPMbI U3Me-
pSIIOTCS B CIELMaJbHBIX €IWHUIIAX — TBUMAX. 3agaBaTb 3HAYEHUS
CBOMCTB Width U Height B TBUIAx HeyaoOHo. ['opasno mpolie 3axBa-
TUTb ONWH W3 HAXOMAIIMXCA Ha TpaHUIle (GOpMBI YepHBIX KBaapaTH-
KOB U TNEPEMECTUTh TpaHUlly (BEpTUKAIbHYIO, TOPU3OHTAJIbHYIO WU
00e cpa3y) B HyXKHOM HampasieHuu (puc. 2.3). ITo okoHuaHuu mne-
peMellleHrs] TpaHU1bl 3HAUYEHUSI CBOMCTB Width U Height aBTOMaTH-
YecKH U3MEHSITCS U OyIyT COOTBETCTBOBATb YCTAHOBJIEHHOMY pa3me-

py GOpPMEL.

Puc. 2.3. MIameHeHne pazmepa Gopmbl
nyTeM NepemMeLLeHNs rpaHnLpl

ITpu BbIOOpE HEKOTOPBIX CBOMCTB (HAmpuMep, BorderStyle) clipaBa
OT TeKYIIEro 3HAaUeHUsI CBOMCTBA MOSIBIISIETCSI 3HAUOK pacKpbIBalolle-
roca crrcka. O4eBUAHO, YTO 3HAYCHWE TAaKWX CBOMCTB MOXHO 3a-
JaTh TMyTeM BblOOpa M3 crnucka (puc. 2.4). 3aech cienyeT oOpaTUTb
BHUMMAaHHE Ha TO, YTO B CIIMCKE CHayaja yKa3bIBAeTCsl YMCIOBOE 3HA-
yeHue KOHCTaHThbl, a 3aTeM — ee HazBaHue. [Ipu aToM He ciemyer
IyTaTh Ha3BaHWE KOHCTAHTHI M ee obosHaueHwWe. Hampwmmep, umc-
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JICHHOE€ 3HAa4Y€HMWE€ KOHCTAHTBI Fixed Single paBHO eIWHHULE, A
CHUMBOJIBHOE€ 3HAYE€HUE PABHO vbFixedSingle.

Puc. 2.4. IameHeHne 3Ha4yeHns CBOMNCTBA
nyTem Bblbopa 13 cnmncka

PanoMm co 3HaueHUSIMM HEKOTOPBIX CBOMCTB OTOOpaxkaeTcsl KOMaHI-
Hag KHONKAa C TpeMs TOYKaMU. DTO 3HAYMT, YTO IJIT W3MEHEHUS
3HAYEeHUsI CBOMCTBA UCIOIb3YETCsl MTOMOJHUTEIbHOE AMATOTOBOE OK-
Ho. Hammpumep, B pesynibrare Ieadka Ha KHOIKE C TPeMST TOYKAMH B
CTpOKe cBoOlcTBa Icon OTKpbiBaeTcss okHo Load Icon, B koTopom
MOXHO OTKPBITb OJWMH M3 KATAJIOrOB KOMIIbIOTepa M BBIOpATh ico-
daiin (KapTUHKY, KoTopas OymeT M300paxaTb CUCTEMHOE MEHI0 B
3aroJioBKe (PopMbl).

B Tabn. 2.2 npuBeneHbl 3HAYEHUSI CBOMCTB CTapTOBOI (hopMbI paspa-
OaTbiBaeMoil mporpammbl. OcTalbHble CBOMCTBA OCTaBIE€HbI 0e3 U3-
MEHEeHUS U B TaOJule He MPUBEICHBI.
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Tabnuya 2.2. 3Ha4eHusa CBOVICTB CTapTOBOU ¢hopMbi

CaolicTBO 3HaveHue
Caption KonBepTOp
Width 4425

Height 3705
BorderStyle Fixed Single
MaxButton False
MinButton False
StartUpPosition CenterScreen
ScaleMode Pixel

Font Tahoma, oOpmuHEM, 10
KoMnoHeHTbI

IIporpamma mepecyera IeHBI W3 JOJJIAPOB B PYOIM MOJKHA TTOJTY-
YUTh OT IIOJb30BaTeNsI MCXOMHBIC NaHHBIE — Kypc (COOTHOIIIEHHWE
pyons K dojutapy) W IieHy B mojurapax. B TTOmOOHBIX ITporpammax
JaHHBIE C KJIABUATYphl BBOAAT B TOJNIA pelakTupoBaHus. [1osToMy B
dopMy paspabaTeIBaeMOTO TPUJIOKEHUS HAmo JTOOABUTH JBA OIS
pETaKTUPOBAHUS — JIBA KOMITOHEHTA TextBox.

Hns Toro 4roObl 100aBUTh B (DOPMY KOMITOHEHT TextBox WU JPY-
roii KomMnoHeHm, HEOOXOAMMO:

1. B okne ToolBox BbIOpaTh 3TOT KOMIOHEHT (IIEJIKHYTh Ha 3HAYKe
KOMITOHeHTa) (puc. 2.5).

2. YCTaHOBHTH yKaszaTelb MBIIIA B Ty TOYKY (OPMEI, B KOTOPOIt
IOJDKEeH OBITH JIEBBIM BEpXHMI YroJl KOMITOHEHTa, W HaXarb Jie-
BYIO KHOITKY MBITIIN.

3. TlepemecTuTh yKaszaTeiab MBIIIM B Ty TOYKY, B KOTOPOM MOJKEH
OBITH TMPaBbIii HUXKHUN YTojl KOMIIOHEHTA, M OTIYCTUTb KHOIKY
MBIIIIH.

B pesynbrare 3THX meiicTBUil Ha (popMe IMOSBUTCS KOMITOHEHT.
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